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Stakeholder/Approval (prior to CMS)
Script Creation, Review & Approval Process

	Activity
	Date

	1. Initial revision (Rev 0.5) published on SharePoint


Add other notes in red.
	6/07

	2. Peer review completed


	6/07

	3. Other stakeholders review completed (agency)


	7/07

	4. Rev. 1.0 published & approved


	8/07

	5. Script moves into document change control
	8/07

	6. Script updates based on Parent Guide review
	1/08
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[Capture all stakeholders and roles for the requirements document if available. These are the people who provided input into the content, but not necessarily the ones who make trade-off decisions.]
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	Date Reviewed/Approved
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	Project Managers
	Reviewed

	Jim Sweet, ICT
	Lead Content Writer
	Reviewed

	CPS, Stefanie Hausman, Kristen Merrill, 
	Peer Reviewer
	Reviewed

	Mary Millhollon
	Editor
	Reviewed

	Laurye Clampitt, Stefanie Hausman
	Final Reviewer
	Reviewed

	Anne Batey
	Intel Approver
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	Release and QA Manager
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[2nd level tabS]
Tab 1: [Research, Write, Present]

Tab 2: [Make Decisions with Data]

[TITLE HIGHLIGHT BOX 1 ON RIGHT]
Benefits of Technology Literacy Projects
[highlight Box TEXT]

Technology Literacy meets ISTE National Educational Technology Standards for Students (NETS•S)!

Read more > (PDF; 2 pages)
Explain with Technology
The second level of Technology Literacy includes two projects that empower students in the middle grades, ages 11 through 14, to understand and explain complex topics in any subject area. In these projects, your child researches a complex topic, writes an expository essay on the topic, and explains the topic to a live audience. When you participate, Explain with Technology can help your family use technology more efficiently, effectively, responsibly, and safely.
In Explain with Technology projects, you can:
· Promote creativity and innovation
· Foster critical thinking and decision making
· Help your child build research skills and information fluency

· Encourage collaboration and communication

· Cultivate technology literacy and responsible digital citizenship

Research, Write, Present >
How can you help your child develop rigorous research skills while encouraging objectivity? You can participate in the Research, Write, Present project to support your child’s research into a complex topic and encourage expository writing about real events. In this project, your child becomes a more effective communicator by designing and delivering a multimedia presentation to a live audience.
Make Decisions with Data >
How can you provide opportunities for your child to learn, practice, and apply rigorous decision making skills? You can participate in the Make Decisions with Data project to help your child define an important decision and collect and analyze opinion data to inform the decision. In this project, your child becomes a more effective communicator by presenting the decision to a live audience.
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Project Overview
In the Research, Write, Present project, your child develops fundamental skills needed to use technology to support research, creativity, and communication. Your child can then use technology tools and resources more effectively to create and communicate knowledge by gathering and organizing information, and presenting what they know to an audience.
Expository Writing >
In the first module, your child explores how authors use the expository style of writing to explain a topic in an interesting and informative manner. You can help your child learn how to present all relevant information on a topic without favoring any particular point of view. You child also learns how to use the Internet safely.
Research Process >
In the second module, your child explores the research process and learns how to locate a variety of credible sources of accurate and reliable information. Your child learns when and how to quote, paraphrase, and summarize sources by taking notes. Your child also learns how to use e-mail as a research tool, use graphic organizers to answer research questions, and outline an essay.
Expository Essay >
In the third module, your child learns how to use technology tools to draft, revise, and edit expository essays. Your child drafts introductory paragraphs that get readers interested in a topic, body paragraphs that explain the topic, and concluding paragraphs that summarize the topic. Your child uses peer feedback to make an essay more interesting and informative, and your child edits the essay carefully to remove mechanical errors.

Multimedia Presentation >
In the last module, your child learns how to use technology tools to create and deliver a multimedia presentation that is entertaining as well as interesting and informative. You can help your child find images, audio, and video to enhance the presentation, making sure your child uses the multimedia legally and ethically.
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Module Overview
In this module, your child learns that the purpose of an expository essay, or exposition, is to explain a topic in an interesting and informative manner. Your child should know the characteristics of expository writing and be able to analyze an exposition’s effectiveness. You can help your child recognize various types of expository writing in everyday reading. In this module, your child chooses a complex topic to explain, without favoring, any particular point of view.

Activity 1: Expository Style

Your child explores the expository style of writing. Your child reads and analyzes expository essays to demonstrate knowledge of what makes an effective expository essay.
Activity 2: Internet Safety

Your child explores important guidelines for Internet safety. Your child uses the expository style to explain three ways to use the Internet safely.
Activity 3: Expository Types

Your child explores some useful types of expository writing, such as compare-and-contrast and cause-and-effect. Your child reads and interprets expository writing on subjects of interest.

Activity 4: Topic Choice

Your child explores how to use expository writing to learn about a subject of interest.
Your child selects an appropriate topic to explain in an expository essay.

Activity 5: Research Questions

Your child explores how effective research questions can provide focus when researching a topic. Your child learns how to write questions to help guide research.
Next to Vocabulary >
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about expository writing. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.

[image: image1.png]



Expository Style

Audience: The people who read a publication or view a work of art, performance, or presentation.
Data: Information collected by observation or measurement.

Essay: A short written work that makes an important point about a particular topic.

Expository: A type of writing that explains a topic or informs an audience.

Fact: Information widely believed to be true and supported by objective data.
Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.

Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Nonfiction: Any creative work that describes or comments on actual events, such as a newspaper article or biography.

Objective: Able to put aside personal feelings and opinions.
Opinion: Beliefs that may or may not be supported by facts.
Third Person: A type of writing that tells a story by using pronouns that refer to a character in the story, such as he, she, or they.
Internet Safety

Internet: A network that connects millions of computers in more than 100 countries around the world.

Network: A system of computers connected either by wires and cables or wirelessly by antennas and towers.

Password: A secret series of letters, numbers, and symbols used to prove that a person has the right to use a computer or access information.

Protocol: A set of rules that controls how computers on a network exchange information.
Expository Types

Cause: A person, group, event, idea, action, or object that produces a specific result or outcome.

Classify: Arrange people, groups, places, events, ideas, actions, or objects so that each one is assigned to a category.

Compare: Study two (or more) people, groups, places, events, ideas, actions, or objects to identify shared characteristics.

Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.
Divide: Separate people, groups, places, events, ideas, or things so that each one is placed into a category.

Effect: A specific result or outcome produced by something said or done by a person, group, event, idea, or thing.

Interpret: Understand or explain meaning.
Topic Choice

Brainstorm: Think of many possibilities as quickly as you can.
Research Questions
Convergent: Moving toward one direction or having a limited number of answers.

Divergent: Moving in many directions or having many answers.

Evaluative: Requiring judgment to decide among various opinions or answers.

< Back to Expository Writing | Next to Exploration >
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Web Sites to Explore with Your Child

You can help your child learn about expository writing by exploring some Web sites together. Your child should also become familiar with basic Internet safety guidelines. While exploring the following Web sites, have your child explain the expository writing concepts learned in school.


Expository Style

In the following Web sites, your child explores the expository style of writing. Expository essays focus on objective information, such as facts and data. A well-written exposition presents all relevant information without favoring any particular point of view.

· You Got Some 'Splaining to Do, Lucy: Exposition* from Fact Monster*
· Writing Workshop: Research Paper* from Scholastic*

· Expository Essay* from Essay Info*
Internet Safety

In the following Web sites, students explore basic ways for keeping themselves, their families, and their schools safe when they use the Internet. Your child learns that the best policy is never to say or do anything online that you would not say or do anywhere else.

· Kids’ Rules for Online Safety* from SafeKids.com*

· Use Your NetSmartz* from NewSmartz Workshop*

· Passwords* from Learn the Net.com*

Expository Types

In the following Web sites, your child explores some useful types of expository writing, such as compare-and-contrast, classify-and-divide, and cause-and-effect. Your child learns how to distinguish different expository types and use them to become a better writer, reader, and learner.

· You Got Some 'Splaining to Do, Lucy: Exposition* from Fact Monster*
· Types of Essays and Student Samples* from Roane State Community College*

Topic Choice

In the following Web sites, your child explores how expository writing can be used in arts and literature, history, math, or science. Your child chooses a topic for an expository essay and thinks about what type of expository writing is most appropriate for explaining the topic.

· Establish Your Topic* from Fact Monster*

· Choosing the Topic* from Essay Info*

· How to Brilliantly Brainstorm a Topic* from Scholastic*

Research Questions

In the following Web sites, your child explores how writing a few effective research questions can privide focus when researching a topic. Your child learns how to ask different types of questions to get more than one type of information about a topic.

· What's the Question?* from Fact Monster*

· How to Impress Your Teachers by Asking Good Questions!* from the Big6*
· Creating Research Questions* from Wheeling High School*

< Back to Vocabulary | Next to Information >
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about expository writing.

Expository Style
Your child should understand the essential information about expository writing needed to complete this project successfully. The expository style of writing is a good choice when an author wants to tell readers about a topic or show readers how to do something.
Your child should know that:

· An essay is a short written work that makes an important point about a topic chosen by the author.
· An expository essay is a short written work that explains a topic or informs an audience.
Expository essays:
· Present all relevant information without favoring any particular point of view
· Focus on objective information, such as facts and data
· Are usually written in third person, using pronouns such as he, she, or they
Internet Safety
The Internet is real, and what a person says and does online matters. Your child should always practice Internet safety whether sending e-mail, instant messaging, or surfing the Web.
Your child should know the basic guidelines for Internet safety:
· Never give out personal information online. Never give out information that someone could use to identify you, your family, or your school.

· Remember that the Internet is real. What you say about other people online has just as much effect as what you say to them in person.

· Use strong passwords and keep them secret. Passwords protect information by making sure that only authorized people can get access.

· Know the rules anywhere you go online. Many people use computers in more than one place, such as schools, homes, libraries, cafés, and friends’ houses. Always know the rules for using any computer.
Expository Types
You can help your child understand that the expository style can be used to write about almost any topic in almost any subject. While most expository types can be used in almost any subject, some are particularly useful in certain subjects.
Your child should be able to distinguish the following five types of expository writing:
· Cause-and- effect expositions explain why an event happens.

· Classify-and- divide expositions sort people, groups, places, events, ideas, actions, or objects into categories based on similarities and differences.
· Compare-and-contrast expositions explain the similarities and differences among people, groups, places, events, ideas, actions, or objects.

· Definition expositions explain the most important characteristics of a person, group, place, event, idea, action, or object.

· Process expositions tell an audience how to complete an action. They follow a sequence from a starting point to a successful conclusion.
Topic Choice
Your child should understand how to learn about arts and literature, history, math, or science by writing an expository essay on a topic in those subjects.

Your child should know how to:

· Make a list of topics by freely brainstorming ideas

· Evaluate the topics and identify a topic of interest that can be used to tell a meaningful story

· Narrow the focus of the topic to a single event

· Check for sources to make sure enough information can be found about the topic

Research Questions
Your child should be able to distinguish among four types of questions:

· Fact questions always have a correct answer.
· Convergent questions require more explanation than fact questions, but they usually have correct answers.
· Divergent questions usually have many acceptable answers.
· Evaluative questions require judgment to decide among various opinions or answers.
< Back to Exploration | Next to Reflection >
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[TITLE HIGHLIGHT BOX 1 ON RIGHT]
Reflection Resources

[highlight Box TEXT]

Preview an example of research questions before reflecting on your child’s work.
See the example: 
Microsoft Word* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child explored expository writing skills, selected a good topic for an expository essay, and wrote some effective research questions.

Asking your child to share research questions helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about expository writing

· Why your child chose a particular expository topic
· What your child learned about research questions

· How to write effective research question

< Back to Information | Next to Application >

[PRORAMMING INSTRUCTIONS]
The example below is available for translation and located under the Content and Files Tab > Explain > Describe, Write, Present Examples
	Microsoft* Word


	http://download.intel.com/education/common/country_code
/resources/TechnologyLiteracy/Explain/ResearchWritePresent/EW_ResearchQuestions_Example.doc

	PDF
	http://download.intel.com/education/common/country_code
/resources/TechnologyLiteracy/Explain/ResearchWritePresent/EW_ResearchQuestions_Example.pdf


The Rubric below are available for translation and located in the Describe, Write, Present Content Script on the Technology Literacy File Sharing site under the Content and Files Tab > Explain 

	Rubric: Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/ExpositoryWriting_Rubric.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/ExpositoryWriting_Rubric.pdf
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[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Help Guide

[highlight Box TEXT]

Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
##Search the Help Guide#skillid=null##
Applying Your Child’s Knowledge

You can help your child better understand expository writing by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for expository writing. Discuss the activities with your child and select any that interest you.

Family Expert

Brainstorm a list of activities that your child enjoys or special talents your child has. Have your child choose one activity or talent and write a process exposition explaining how to do it. Then, have your child demonstrate the activity or talent to other family members.

Nature Hike

Take an outdoor walk with your child and collect samples of a natural object, such as leaves, plants, soil, or insects. Discuss with your child the similarities and differences among the objects you collect. Have your child write a compare-and-contrast or classify-and-divide exposition about the objects you collected.
News Views

Choose a topic in the news that interests both you and your child. Have your child identify articles that attempt to explain the topic in two different newspapers or magazines and read both articles aloud to you. Then, have your child compare the types of expository writing used in the articles. Discuss with your child whether the explanations offered by each author were informative.

< Back to Reflection | Next to Research Process >
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Module Overview
In this module, your child learns how to locate a variety of credible sources of accurate and reliable information on a topic. Your child should know when and how to quote, paraphrase, and summarize sources by taking notes. Your child should also know how to use graphic organizers and outlines to answer research questions and write an effective expository essay. Your child should understand how effective research strategies can help cultivate success in school, work, and life.
Activity 1: Research Strategies

Your child learns how to use keyword searches to find information in library catalogs, databases, and Web sites. Your child locates some credible sources to help answer a research question.

Activity 2: Information Gathering

Your child explores how to gather reliable and accurate information. Your child quotes, paraphrases, and summarizes sources to gather information on a research question.
Activity 3: Electronic Mail

Your child explores how e-mail offers the possibility of exchanging written messages with millions of people in the world. Your child finds e-mail sources relevant to the topic of an expository essay.

Activity 4: Graphic Organizer

Your child explores how a graphic organizer can be used to arrange many pieces of information into a few logical ideas or concepts. Your child graphically organizes gathered information.

Activity 5: Essay Outline

Most successful writers plan the essays they want to write before they begin writing. To help ensure success, your child uses a graphic organizer to outline an expository essay.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about the research process. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Research Strategies
Accurate: Careful to provide true information.

Cite: Refer to a source of information, usually in a formal way.
Credible: A source you can trust to provide true information.
Criterion: A rule or guide used to measure value and aid in decision making.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.
Hit: A successful match between keywords and Web sites returned by a search engine or directory.

Keyword: A word that is related to a topic in an important way and helps you find more information about the topic.
Reliable: Capable of producing accurate results every time.
Research: Study a topic carefully using credible sources.

Search Directory: A Web site that categorizes Web pages by subject to make searching easier.

Search Engine: A program that scans the Internet and creates a database of the words contained in Web sites so users can find Web pages containing specified keywords.

Source: Anything or anyone providing information about a topic.
Information Gathering

Paraphrase: Restate an author’s ideas using different words.

Plagiarism: Copying or making slight changes in a written or created work and presenting it as a new or original work.

Quote: Use another person’s exact words.

Summarize: Explain the main points and important details of an author’s ideas.
Electronic Mail

Application: A computer program designed for a specific purpose.

Attachment: A computer file sent or received with an e-mail message.

Body: The main content of a written work, not including parts with specific purposes.

Client: A computer or application that gets information from another computer or application through a network.

E-mail: Electronic messages sent through a computer network; can be sent with other files attached.

Header: Contains e-mail addresses of the sender and recipients and the subject of a message.

Server: A computer or application that provides information to other computers or applications on a network.

Graphic Organizer

Concept (or Idea): A thought that combines specific information into a general statement.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Graphics: Using pictures and other visual elements to communicate information.

Organize: Combine separate pieces of information into a logical whole.

Essay Outline

Outline: A general overview or summary of the basic structure of information.
Structure: An arrangement of specific parts in ordered relationships to form a whole.

< Back to Research Process | Next to Exploration >
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Web Sites to Explore with Your Child

You can help your child learn about the research process by exploring some Web sites together. While exploring the following Web sites, have your child explain the research concepts learned in school.


Research Strategies

In the following Web sites, your child learns how to locate credible sources and find accurate and reliable information. Your child explores a variety of sources, such as books, encyclopedias, databases, and the Internet. Your child also learns how to use keyword searches to find information in library catalogs, databases, and Web sites.

· How to Write a Research Paper* from Fact Monster*
· Grades 7-12* from the Big6*
· Worlds of Web Searching* from KidsClick!*

· Critical Evaluation of a Web Site* from Discovery School*

· WWW CyberGuide Ratings for Content Evaluation* (PDF; 1 page) from Cyberbee*

Information Gathering

In the following Web sites, your child explores how to gather reliable and accurate information from sources. Your child learns when and how to quote, paraphrase, or summarize ideas.

· How to Write a Research Paper* from Fact Monster*
· What Is Plagiarism?* from FactMonster*
· Grades 7-12* from the Big6*
· Best Note-Taking Strategies* from Scholastic*

Electronic Mail

In the following Web sites, your child explores how e-mail offers the possibility of exchanging written messages with millions of people in the world. Your child explores how e-mail works by learning about its four basic components—address, message, mail client, and mail server.
· The Animated Internet: How E-mail Works* from Learn the Net.com*

· E-mail* from For Kids by Kids Online*

· E-mail* from actDEN*
· How E-mail Works* from How Stuff Works*

Graphic Organizer

In the following Web sites, your child explores how graphic organizers help arrange many pieces of information into a few logical ideas or concepts. Your child learns how to select and use graphic organizers to help put ideas together and demonstrate knowledge about a topic.

· Graphic Organizers* from SCORE*

· Graphic Organizers* from Education Oasis*

· Tools for Reading, Writing, and Thinking* from Greece Central School District*
· Samples* from www.GraphicOrganizers.com*

Essay Outline

In the following Web sites, your child explores how most successful writers plan the essays they want to write before they begin writing. Your child learns how to plan an expository essay by creating an outline based on a graphic organizer.

· Outline* from Essay Info*

· Why and How to Create a Useful Outline* from the Online Writing Lab*

· Sample Outline* from the Online Writing Lab*
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What Your Child Should Know
This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about the research process.

Research Strategies
The single most important strategy for successful research is to use a variety of sources, such as books, encyclopedias, databases, periodicals, and the Internet. Your child should understand how to use keywords effectively in each context.

Some strategies to narrow an Internet search are to use:

· Additional keywords
· Quotes around names or exact phrases
· AND or a plus sign (+)

· NOT or a minus sign (-)

Some strategies to expand an Internet search are to use:

· Fewer keywords

· OR

Evaluation requires judging a Web site against specific criteria. Many lists of criteria are available, but they all have at least three goals in common. They all include criteria to make sure that a Web site is a credible, accurate, and reliable.
Information Gathering
Plagiarism is failing to cite a source you have quoted, paraphrased, or summarized. Your child should be able to explain the difference between paraphrasing and summarizing a source. Summarizing involves more analysis than paraphrasing. You can help your child understand that summarizing sources is the best way to avoid plagiarism, but all sources must still be cited in a bibliography.

Your child should be familiar with five basic types of notes:

· Quote. Copying an author’s exact words is the simplest way to take notes.
· Paraphrase. Restating an author’s ideas using different words is often the best way to take notes.

· Summary. Explaining the main points and important details of another author’s ideas is usually the most efficient way to take notes.

· Facts and Data. Recording facts or data from a source is sometimes useful.
· Original Ideas. Recording unique ideas while gathering information is important.
Your child can use a word processing application to take notes and should be aware that specialized computer programs can also help with note taking. Electronic notes have the advantage of being easy to organize as well as quick and easy to search.

Electronic Mail
E-mail has been one of the most popular online activities since the beginning of the Internet.
Your child should know four basic components of e-mail:
· Address. Every person who sends or receives e-mail must have a unique address. An example of an e-mail address is:

john.doe@intel.com

· Message. An e-mail message has two main parts—a header and a body. The header contains the addresses of the sender and recipient(s) and the subject of the message while the body contains the contents of the message.

· Mail Client. A computer or application that gets information from another computer or application through a network is called a client. A mail client is an application used to send and receive e-mail.

· Mail Server. When an e-mail is sent, a mail client routes the message to a mail server. Servers are computers that are shared by many users.

Graphic Organizer
Your child should understand that graphic organizers are ideal tools for arranging many pieces of information into a few logical concepts or ideas. An effective graphic organizer is a visual representation of knowledge. You may want to discuss the difference between information and knowledge with your child.

Your child should be familiar with the following graphic organizers:

· The fishbone is a popular graphic organizer for showing cause-and-effect relationships.

· A Venn diagram is a popular graphic organizer for comparing and contrasting two or more concepts or ideas.
· A clustering diagram, also called a concept map, is an effective way to sort and group information into categories.

· Some graphic organizers, such as interaction outlines and problem-solution, represent special processes.
Essay Outline
Your child should understand how to distinguish the main points needed to explain a topic from the supporting points that explain the main points. Main points are usually the most important concepts identified in a graphic organizer. Supporting points are smaller concepts or facts and data used to develop the bigger concepts.

Your child should know how to use the following steps to create an outline:

1. Identify main points to explain your topic

2. Determine the most logical order of main points

3. Give each main point a short, descriptive label

4. Identify the supporting points to explain each main point

5. Determine the most logical order of supporting points for each main point

6. Give each supporting point a short, descriptive label
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Preview an example of an expository essay outline before reflecting on your child’s work.
See the example: 
Microsoft Word* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work
In this module, your child located, quoted, paraphrased, and summarized credible sources of information. Your child used notes to create a graphic organizer and used a graphic organizer to outline an essay.

Asking your child to share the expository essay outline helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· How different kinds of sources were located and determined to be credible

· How notes were used to quote, paraphrase, and summarize sources

· How e-mail was used to find additional sources on a topic

· What was learned about a topic through the creation of a graphic organizer

· How a graphic organizer helped to outline an expository essay
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Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
##Search the Help Guide#skillid=null##
Applying Your Child’s Knowledge

You can help your child better understand the research process by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for developing research skills. Discuss the activities with your child and select any that interest you.

Family Expert II
Discuss with your child the activities your child enjoys and special talents your child has. Have your child choose one activity or talent to learn more about. Help your child find an expert to e-mail for more information about the activity or talent. Have your child e-mail the expert.  Make sure your child asks the expert specific questions with answers that are not readily available from other sources, such as newspapers, magazines, encyclopedias, or Web sites.
News Views II
Choose an event in the news that interests both you and your child. Have your child identify articles that attempt to explain the topic in at least four different newspapers, magazines, or Web sites and take notes on the articles. Discuss with your child some of the possible causes and effects of the event. Have your child create a graphic organizer representing the most likely causes and effects based on the information your child gathered. Then, have your child outline an explanation of the event based on the graphic organizer.
Success Story
Choose an important figure from entertainment, politics, or sports that you and your child admire. With your child, use a variety of search engines and search directories to find sources of information about the person. Have your child gather and organize information from the sources that helps to explain why the person became successful. Have your child outline an informative biography of this person’s career.
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Module Overview
In this module, your child learns that expository essays usually begin with an introductory paragraph that gets readers interested in a topic, includes three (or more) body paragraphs that explain the topic, and ends with a concluding paragraph that summarizes the topic. You can help your child understand the importance of revising essays to improve content and strictly editing essays to remove mechanical errors.

Activity 1: Introductory Paragraph

Your child learns how to engage an audience in an essay by introducing the topic in clear and interesting ways. Your child drafts introductory paragraphs for an expository essay.

Activity 2: Body Paragraphs

Your child explores techniques for explaining a topic in an interesting and informative manner.

Your child uses an outline to draft body paragraphs that explain a topic thoroughly.

Activity 3: Concluding Paragraph

Your child explores techniques for offering readers new viewpoints or insights in a memorable manner. Your child drafts a concluding paragraph that summarizes and synthesizes an essay.

Activity 4: Peer Review

Your child explores how revision helps authors create the most interesting and informative essays they can write. Your child use peer review to revise an expository essay.

Activity 5: Writing Mechanics

Your child explores word processing tools than can help with finding and correcting mechanical errors. Your child edits an expository essay to find and correct mechanical problems.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about expository essays. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Introductory Paragraph
Draft: An unfinished version of a creative work.

Introduction: The beginning of a work that leads into the main body of the work.

Paragraph: A group of sentences focusing on one idea or concept, which begins on a new line and ends with a return to a new line.

Transition: Movement from one idea or concept to another in a creative work.

Body Paragraphs

Analyze: Study carefully to identify and understand essential parts.

Concluding Pargraph

Synthesize: Produce something new by combining existing information to form a new idea or concept.

Peer Review

Antonym: A word that means the opposite of a particular word.

Peer: A person who is similar to another, as in age, grade, or career.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Revise: Carefully review and improve the content of a creative work.
Synonym: A word that has the same meaning as another word.
Thesaurus: A reference that contains lists of synonyms and antonyms.

Writing Mechanics

Edit: Prepare the final version of a creative work by fixing problems with mechanics.

Mechanics: The technical part of writing that includes spelling, punctuation, capitalization, sentence structure, and grammar.
Proofread: Read to find problems with writing mechanics before a document is shared with an audience.
Typographical Error: A problem with writing mechanics that results from a typing or word processing mistake.
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Web Sites to Explore with Your Child

You can help your child learn about writing an expository essay by exploring some Web sites together. While exploring the following Web sites, have your child explain the expository essay concepts learned in school.


Introductory Paragraph

In the following Web sites, your child learns how to introduce a topic to an audience in a clear and interesting way. If the audience believes that an essay will be clear and interesting, they will be encouraged to continue reading the essay.

· Paragraph Development* from Orange Unified School District*

· Writing Introductions* from Orange Unified School District*

· Organizing the Paragraph* from Essay Info*

· Introduction* from Essay Info*

Body Paragraphs
In the following Web sites, your child explores techniques for explaining a topic thoroughly in body paragraphs. Your child learns how to make an essay interesting and informative by using an outline to make sure that the essay is well organized and complete.

· Body* from Essay Info*

· How Do I Write Body or Support Paragraphs?* from Paradise Valley Community College*

· Transitions* from Orange Unified School District*

· Transitional Devices* from the Online Writing Lab*

Concluding Paragraph

In the following Web sites, your child learns how to write concluding paragraphs that summarize a topic and combine main points in an essay to create new ideas or concepts. Your child explores techniques for offering a new viewpoint or insight and making a lasting impression on readers.

· Conclusion* from Essay Info*

· Writing a Conclusion* from Orange Unified School District*

Peer Review

In the following Web sites, your child explores how the best expository writers revise their first drafts to create the most interesting and informative essays they can write. Your child learns how to look at writing from different points of view. You child also learns how to use word processing tools to track changes during revisions and make suggestions during peer reviews.

· Revising Your First Draft* from Fact Monster*

· Writing Workshop: Revise* from Scholastic*

· Write It: Giving Meaningful Feedback* from Scholastic*

· Write It: Handling Feedback* from Scholastic*

Writing Mechanics

In the following Web sites, your child learns that poor writing mechanics can make even the most interesting and informative expositions hard to read. Your child learns that word processing tools can find and correct mechanical errors, but the tools are not substitutes for good judgment.

· Proofread the Final Draft* from Fact Monster*

· Writing Workshop: Edit* from Scholastic*

· Writing Workshop: Review* from Scholastic*
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about expository essays.

Introductory Paragraph
Effective paragraphs are the building blocks of any well-crafted essay. Effective paragraphs usually have at least two common characteristics:

· State the main point of the paragraph clearly. The main point that will be developed should be clearly stated in a sentence, often called the topic sentence.
· Present supporting points in a logical order. Supporting points should be presented in an order that leads readers to the main point.

An effective expository essay usually begins with an introductory paragraph that gets readers interested in the topic. Effective introductory paragraphs usually have at least three common characteristics:

· Tell readers what the essay is about
· Engage readers in the topic

· Tell readers what they will get from the essay

Body Paragraph
The body is the main content of any essay. In an expository essay, the body paragraphs must provide enough information to explain the topic thoroughly.
Effective body paragraphs usually have some common characteristics:

· Explain one main point
· Provide information to support the main point

· Present main points in a logical order

· Follow an outline to structure the essay

· Connect main points with smooth transitions

· Balance the structure of the essay

Your child should understand how to connect main points by using transition words in a topic sentence or concluding sentence.
Concluding Paragraph
Your child should understand the importance of leaving readers with a clear and satisfying conclusion that stays in their memories.
Effective concluding paragraphs usually have some common characteristics:

· Remind readers what the essay has explained

· Offer readers a new viewpoint or insight

· Make a lasting impression on readers
Peer Review
Your child should understand the importance of being as objective as possible when revising an essay. You can remind your child that revising is about looking at writing from different points of view and focusing on content rather than grammar, spelling, and punctuation. You can help your child understand the need to put aside personal feelings and opinions.

Peer review is one of the most effective ways to get another point of view. When reviewing an essay, your child should point out the parts that are especially well-crafted as well as any parts that may need to be revised. The most effective peer reviews offer specific suggestions for improvement.

Writing Mechanics
Editing involves finding and correcting problems with writing mechanics. Your child should know how to use word processing tools to help check both spelling and grammar. Your child should also understand that word processing tools are not substitutes for good judgment.
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Preview an example of an edited expository essay before reflecting on your child’s work.
See the example: 
Microsoft Word* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child drafted an essay with an engaging introduction, informative body paragraphs, and a memorable conclusion. Peer reviews helped to make the essay more interesting, informative, and memorable. Finally, your child edited the essay to make sure readers are not distracted by mechanical errors.

Asking your child to share the expository essay helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about writing effective paragraphs

· How an essay engages readers

· How an outline can be used to explain a topic thoroughly

· How to make sure readers will remember an essay
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Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
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Applying Your Child’s Knowledge

You can help your child better understand expository essays by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for writing expository essays. Discuss the activities with your child and select any that interest you.

Family Expert III
Have your child draft a how-to essay on the activity or talent selected when e-mailing an expert to gather information. Have your child give the essay to other family members or friends and ask them to perform the activity or talent using only the essay for instructions. Ask the other family members or friends to point out any problems they encountered and offer suggestions for making the essay easier to follow. Have your child revise the essay and share the final essay with family and friends. You may also want to videotape your child explaining how to perform the activity or talent and share the video with family or friends.
News Views III
Discuss the graphic organizer and outline your child created to explain an interesting event in the news. Have your child draft, revise, and edit an original news article about the topic. Read your child’s draft and discuss ways to make the article more interesting and informative. Could the introductory pargraph be more engaging? Do the body paragraphs omit some important details? Does the concluding paragraph summarize your child’s explanation of the event in a memorable way?

Success Story II
Have your child draft an informative biography about the important figure from entertainment, politics, or sports that you and your child admire. The biography should explain why the person had a successful career. Read your child’s draft and suggest ways to make the biography more interesting and informative. After your child revises the biography, make sure your child uses word processing tools to check spelling and grammar, and edits the biography carefully and systematically.
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Module Overview
In this module, your child learns how to use technology tools to explain a topic to a live audience. Your child should know what technology tools can be used to create and deliver a presentation and be able to use them effectively. You can help your child understand how to create and deliver multimedia presentations that are entertaining as well as interesting and informative.
Activity 1: Presentation Tools

Your child explores technology tools for creating and delivering interesting, informative, and entertaining presentations. Your child uses an essay outline to create a presentation.

Activity 2: Presentation Design

Your child explores visual representations of information. Your child uses principles of graphic design to make a presentation as visually appealing and easy to read as possible.

Activity 3: Multimedia Formats

Your child explores how well-chosen multimedia can enhance a presentation. Your child finds images, audio, or video on the Internet to help explain a topic.

Activity 4: Copyright and Fair Use

Your child explores copyright laws and the conditions and limitations of fair use for educational purposes. Your child identifies the copyright status of multimedia that may be used in a presentation.

Activity 5: Presentation Delivery

Your child explores strategies for delivering interesting, informative, and entertaining presentations to live audiences. Your child prepares, practices, and delivers a presentation to an audience.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about multimedia presentations. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Presentation Tools

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Hardware: Any physical device that is part of a computer or can be used with a computer.
Icon: A picture that represents a specific action for a computer to take.

Input: Data entered into a computer.

Multimedia: Combining more than one type of information, such as words, numbers, images, audio, and video.

Output: Data produced by a computer.

Peripheral: Any device that can provide input to a computer or accept output from a computer.

Presentation: An explanation of a topic given in the presence of an audience.

Presentation Application: A software application designed to create multimedia presentations.

Program: A set of instructions for a computer to perform.
Software: Any computer program and any information included with the program.

Template: A computer file designed to open a copy of itself by default so its formatted content can be used and modified to create similar documents.
Word Processing Application: A software application designed to create documents.

Presentation Design

Alignment: Specific arrangement of type and graphics in a publication.

Balance: Overall distribution of type and graphics on a page to create a desired effect.

Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.

Graphic Design: The art of using type and graphics to communicate information with a desired effect.

Proximity: How close together type or graphics are arranged in a publication or presentation; usually used in design to create a desired effect.

Repetition: Type or graphics used more than once to create a desired effect.

Type: A style of letters and numbers used in a publication or presentation.

White Space: An area of a publication with no type or graphics.

Multimedia Formats

Compress: Change how data is stored so it takes up less space on a computer.

Download: Transfer a file from another computer to your computer.

Extension: A period and letters attached to the end of a filename indicating the file’s format.

Format: A specific way to store a particular kind of data in a computer.

URL (Uniform Resource Locator): The address of a Web page consisting of the protocol and domain name and sometimes the path and filename.
Copyright and Fair Use
Copyright: Law that prohibits any creative work from being used without permission.
Fair Use: Limited use of a copyrighted work for certain purposes, such as education.

Public Domain: Creative works that may be used without permission because the copyright has expired.
Presentation Delivery

Conversational: A casual or informal manner of exchanging information or ideas.
Professional: Meeting standards of behavior appropriate for work places.
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Web Sites to Explore with Your Child

You can help your child learn about multimedia presentations by exploring some Web sites together. Your child should also become become familiar with technology tools for creating and delivering presentations. While exploring the following Web sites, have your child explain the multimedia presentation concepts learned in school.


Presentation Tools

In the following Web sites, your child explores technology tools for creating and delivering multimedia presentations that are entertaining as well as interesting and informative. A multimedia presentation uses words, numbers, symbols, images, audio, and video to explain a topic.

· Microsoft PowerPoint* from Internet4Classrooms*

· 10 PowerPoint Tutorials for Beginners* from About*

· Open Office Impress* from Open Office*

· Open Office Impress Tutorial* from GCF Global Learning*

Presentation Design
In the following Web sites, your child explores how visual representations of information can make a strong impression on people. Your child learns that graphic design is the art of creating publications and presentations that capture and hold the attention of readers and viewers.

· Top 9 Tips for Children* from About*

· Principles of Design* from About*

· Examples of Principles of Design* from About*

Multimedia Formats

In the following Web sites, your child explores how to use a few well-chosen images and audio or video clips to enhance a presentation. Your child learns how to find and use the most effective images, audio, and video in a presentation.
· File Formats and Extensions* from Learn the Net*

· How to Download Files* from Learn the Net*

· How MP3 Files Work* from How Stuff Works*

Copyright and Fair Use

In the following Web sites, your child learns how copyright laws protect the rights of people who create original works. Your child should know the conditions and limitations of fair use of copyrighted materials for educational purposes. Your child should also know when and how to obtain permission to use copyrighted images in a publication.
· Copyright Questions and Answers* from CyberBee*

· Copyright Kids* from The Copyright Society of the U.S.A*

· Fair Use in the K–12 Digital Classroom* from Gayle’s Electronic Classroom*

Presentation Delivery

In the following Web sites, your child explores strategies for delivering interesting, informative, and entertaining presentations to live audiences. Your child learns how to prepare and practice a presentation and speak to an audience in a professional but conversational tone.

· 12 Tips for Delivering a Knockout Business Presentation* from About*

· How to Lose an Audience in 10 Easy Ways* from About*
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about multimedia presentations.

Presentation Tools
A projection device is one example of an output peripheral. A peripheral is a hardware device that can provide input to a computer or accept output from a computer.
A projection device needs two main features to work:

· Projection. The most common type of presentation projection device is the LCD (liquid crystal display) projector. Other types include DLP (digital light processing) and RGB (red, green, and blue) projectors. You can also use television monitors to display presentations to smaller audiences.

· Universal serial bus (USB). Projectors and other peripherals must be connected to a computer to provide input or accept output. In the past, peripherals used various types of connections, such as parallel ports, serial ports, and S-Video ports. Today, USB technology provides a single, high-speed port for any kind of peripheral.

The graphical user interface (GUI) of presentation software shares many common features with the interfaces of other kinds of applications. Your child should be able to identify and explain the purpose of the main menus and toolbars in a presentation application GUI. Your child should know that the Slide Show menu is one feature that presentation applications do not share with the GUIs of other applications.

Presentation Design
A quality presentation looks good, is easy to read from a distance, and communicates a message. Your child should know the basic “dos and don’ts” for designing quality presentations. The overarching theme is to use design elements creatively but correctly and sparingly so designs are visually appealing and easy to read or view.

Your child should be able to identify and explain each of the six basic design principles:
· Alignment makes a publication easy to read.

· Balance sets the tone for a publication.
· Contrast directs a reader’s attention to a specific place or idea.

· Proximity uses space to show how type and graphics are related.

· Repetition helps a reader navigate through a publication.

· White space gives a reader’s eyes a rest.

Multimedia Formats
Computer files are stored in particular formats that are indicated by different file extensions. All formats are good for some purposes but not for others.

· Images can be saved in many formats. Most of the images you find on the Web are GIF or JPEG (or JPG) files.

· Audio, like images, can be saved in many formats. One audio format that almost everyone is familiar with is MP3.

· Video also can be saved in many formats. MPEG is a video format from the same organization that developed the MP3 audio format. Unlike image and audio formats, no video format appears to be the most popular format on the Internet.

Copyright and Fair Use
Copyright laws protect the works of authors, artists, and others by preventing people from changing creative works without permission and claiming the works as their own. Copyright laws also prevent people from profiting from other people’s work without permission. All students should understand that they must assume that a work is copyrighted even when it is not marked with a copyright symbol ©.

Fair use of copyrighted works for educational purposes applies only under certain conditions and limitations. No exact rules exist for fair use in all cases, but your child can follow some accepted guidelines for school projects. Credit must always be given to the creators of images just as authors of text must be cited.

Presentation Delivery
Your child should know how to do the following before delivering a presentation:

· Review the presentation with Slide Sorter on the View menu

· Run the presentation from either the View or Slide Show menu

· Practice delivering the presentation in front of a mirror, friend, or trusted adult

· Connect and use the projector

Your child should know how to do the following during a presentation:

· Speak to the audience in professional but conversational tones

· Summarize the main points on the slides instead of reading from them or reciting them from memory

· Watch the audience to make sure that they are understanding the presentation

· Watch the time and try to stay on schedule
< Back to Exploration | Next to Reflection >

	Type of Page 
	Level 4 Content Page

	Supertitle
	Research, Write, Publish | Multimedia Presentation

	Headline Title
	Reflection


[left-hand nav TEXT]
Vocabulary
Exploration
Information
Reflection

Application

[TITLE HIGHLIGHT BOX 1 ON RIGHT]
Reflection Resources

[highlight Box TEXT]

Preview an example of a final presentation before reflecting on your child’s work.
See the example: 
Microsoft Powerpoint* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child designed an effective presentation, found and downloaded multimedia from the Internet, documented the copyright status of downloaded media, and delivered a multimedia presentation to a live audience.

Asking your child to share the presentation helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about presentation tools

· What was learned about designing effective presentations

· How to prepare to deliver a presentation

· What your child liked about the presentation given and what your child would like to do better next time
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[PRORAMMING INSTRUCTIONS]
The example below is available for translation and located under the Content and Files Tab > Explain > Describe, Write, Present Examples
	Microsoft* Powerpoint

	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/MP_PresentationDelivery_Example.ppt

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/MP_PresentationDelivery_Example.pdf


The Rubric below are available for translation and located in the Describe, Write, Present Content Script on the Technology Literacy File Sharing site under the Content and Files Tab > Explain 

	Rubric: Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/MultimediaPresentation_Rubric.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/ResearchWritePresent/MultimediaPresentation_Rubric.pdf
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Help Guide
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Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
##Search the Help Guide#skillid=null##
Applying Your Child’s Knowledge

You can help your child better understand how to produce and deliver multimedia presentations by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for multimedia presentations. Discuss the activities with your child and select any that interest you.

Multimedia Roundup
Choose a person or place that interests both you and your child. Have your child use the Web to locate as many different types of multimedia related to the person or place as possible during one week. Make sure your child can correctly identify both the file format and copyright status of each example collected. Discuss with your child some of the ways each type of media communicates information about the person or place. Make sure your child can explain strengths and weaknesses of each type of media.

News Views IV
Discuss the article your child wrote to explain an interesting event in the news. Have your child use the Web to locate different types of multimedia related to the event and make sure your child can correctly identify both the file format and copyright status. Have your child use presentation tools and graphic design principles to create a multimedia presentation explaining the event. Have your child deliver the presentation to other family members or friends who have read your child’s news article. Make sure the other family members or friends ask your child any questions they may have about the event and discuss whether multimedia makes your child’s explanation more entertaining or informative.
Success Story III
Have your child use presentation tools and graphic design principles to create a multimedia presentation about the important figure from entertainment, politics, or sports that you and your child admire. Make sure your child uses appropriate images, audio, or video to enhance the presentation, and correctly identifies the copyright status of the media. Have your child deliver the presentation to other family members or friends. Make sure the other family members or friends ask your child any questions they may have about the person’s career and encourage audience members to suggest ways to make your child’s presentation more entertaining or informative.
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[3rd level tabS]

Tab 1: [Decision Making]

Tab 2: [Data Collection]

Tab 3: [Data Analysis]

Tab 4: [Expository Presentation]

Project Overview
In the Make Decisions with Data project, your child develops fundamental skills needed to use technology to support decision making, data analysis, and communication. Your child learns how to use technology tools and resources to help make more informed decisions by collecting and analyzing data. You can help your child consider different points of view with reason and fairness. Your child becomes a more effective researcher, decision maker, and presenter by learning to analyze and visualize data.

Decision Making >
In the first module, your child learns that critical thinkers are effective decision makers because they consider different points of view with reason and fairness. You can help your child understand how surveys collect data on people and their opinions, and how survey data can inform many important decisions about complex topics.
Data Collection >
In the second module, your child learns how to collect opinion data by administering surveys. You can help your child understand that opinions are often useful data because important decisions have significant effects on people. Your child writes survey questions and compiles a questionnaire to collect data from other students. Your child also learns how database applications store and manage data for quick and easy retrieval.

Data Analysis >
In the third module, your child uses a database application to store and manage survey data, and a spreadsheet application to analyze and visualize data. Your child creates forms and queries to enter and retrieve survey data, and uses formulas and functions to analyze data. You can help your child understand how visual representations of data, such as charts and graphs, can help your child evaluate possibilities and make choices.
Expository Presentation >
In the last module, your child shares successful decision making with a live audience by creating, preparing, and delivering an expository presentation. You can help your child reflect on how your child defined decisions, gathered information, developed alternatives, evaluated possibilities, and made choices. Your child uses technology tools to create and deliver presentations that are entertaining as well as interesting and informative.
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Module Overview
In this module, your child learns that critical thinking can help people evaluate alternatives and make important decisions. You can help your child understand that critical thinkers are effective decision makers because they consider different points of view with reason and fairness. Your child should know that surveys collect data on people and their opinions, and survey data can inform many important decisions about complex topics.

Activity 1: Thinking Skills

Your child explores how to examine a complex decision from multiple points of view. Your child analyzes news stories to practice thinking critically about current events.
Activity 2: Survey Data

Your child explores how to use data to help make decisions. Your child analyzes the results of surveys on topics of interest to practice thinking critically about survey data.
Activity 3: Decision Definition

Your child explores how decision making can assist in learning about complex topics. Your child defines important decisions and writes questions to guide research on the decisions.

Activity 4: Information Gathering

Your child explores strategies for gathering accurate and reliable information. Your child takes effective notes that quote, paraphrase, and summarize credible sources.

Activity 5: Decision Alternatives

Your child explores strategies for developing alternative choices. Your child uses a graphic organizer to organize gathered information into different choices for a decision.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about decision making. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Thinking Skills
Accurate: Careful to provide true information.

Brainstorm: Think of many possibilities as quickly as you can.

Complex: Consisting of many parts that are connected or related to one another.

Concept (or Idea): A thought that combines specific information into a general statement.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Consistent: Continuing to agree with specific information or ideas while working toward a goal.
Critical: Careful to evaluate information and draw correct conclusions.

Decision: A choice made after considering available alternatives.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.
Persistent: Continuing to work toward a goal even when an obstacle stands in the way of achieving the goal.
Point of View: The way a person tends to think about people, places, and events based on individual experiences.
Precise: Careful to provide only accurate and relevant information.

Reflective: Careful to focus on thinking about important ideas and concepts.

Relevant: Provide important information about a particular topic.

Survey Data

Average: A number that represents a typical value of a dataset, especially the mean.

Central Tendency: A typical value of the members in a set of data.

Chart: Another term for graph, especially one that uses a picture to show relationships among selected parts of a set of data.

Data: Information collected by observation or measurement.

Dataset: A collection of data records.

Demographics: Basic statistics about a human population. For example, age, gender, race, residence, education, and income.

Fact: Information widely believed to be true and supported by objective data.
Mean: A measure of central tendency calculated by adding the values of a dataset and then dividing the sum by the number of values in the set.

Median: A measure of central tendency calculated by ordering the values in a dataset from lowest to highest and finding the middle value in the set.

Mode: A measure of central tendency calculated by ordering the values in a dataset from lowest to highest and finding the most common value in the set.

Opinion: Beliefs that may or may not be supported by facts.

Percentage: The number of one part of a group compared to the total number in the whole group.

Population: All members of a specific group.

Range: The highest value in a dataset minus the lowest value in the dataset.

Sample: One part of a population that represents the whole population.

Statistics: Facts and data that can be represented by numbers; also the study of numerical facts and data.

Survey: Gather facts and opinions from a sample of a population by asking questions.

Decision Definition

Convergent: Moving toward one direction or having a limited number of answers.

Divergent: Moving in many directions or having many answers.

Evaluate: Determine the usefulness of a source.
Evaluative: Requiring judgment to decide among various opinions or answers.

Information Gathering

Cite: Refer to a source of information, usually in a formal way.
Credible: A source you can trust to provide true information.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Hit: A successful match between keywords and Web sites returned by a search engine or directory.

Keyword: A word that is related to a topic in an important way and helps you find more information about the topic.
Paraphrase: Restate an author’s ideas using different words.

Plagiarism: Copying or making slight changes in a written or created work and presenting it as a new or original work.

Quote: Use another person’s exact words.

Reliable: Capable of producing accurate results every time.

Research: Study a topic carefully using credible sources.

Search Directory: A Web site that categorizes Web pages by subject to make searching easier.

Search Engine: A program that scans the Internet and creates a database of the words contained in Web sites so users can find Web pages containing specified keywords.

Source: Anything or anyone providing information about a topic.
Summarize: Explain the main points and important details of an author’s ideas.
Decision Alternatives

Graphics: Using pictures and other visual elements to communicate information.

Knowledge: Understanding that is achieved through experience and thought.
Organize: Combine separate pieces of information into a logical whole.

Understanding: Ability to see the meaning and importance of ideas and concepts.
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Web Sites to Explore with Your Child

You can help your child learn about decision making by exploring some Web sites together. Your child should also learn how surveys collect data on people and their opinions that can inform many important decisions about complex topics. While exploring the following Web sites, have your child explain the decision making concepts learned in school.


Thinking Skills

In the following Web sites, your child explores how to examine a complex decision from multiple points of view. Your child learns key fundamental skills necessary to think critically about complex decisions.

· Critical Thinking* from Children Taking a Stand*

· Five Steps to Better Critical-Thinking, Problem-Solving, and Decision-Making Skills* from Hillsborough Community College*

· Decision Making* from Answers*
Survey Data

In the following Web sites, your child explores how to use data to help make decisions. Your child learns that data is information that has been collected by observation or measurement, and surveys are used to collect data on people’s opinions.
· Middle School Statistics* from Ask Dr. Math*

· Finding a Percentage* from Ask Dr. Math*

· Interactive Comparison of Mean and Median* from NCTM Illuminations*

Decision Definition

In the following Web sites, your child explores how to use the decision making process to learn about complex topics of interest. Your child learns that defining decisions involves brainstorming potential topics, evaluating the topics, narrowing the focus, and making sure enough accurate and reliable information can be gathered to make a decision.

· Establish Your Topic* from Fact Monster*

· Choosing the Topic* from Essay Info*

· How to Impress Your Teachers by Asking Good Questions!* from The Big6*
· Creating Research Questions* from Wheeling High School*

Information Gathering

In the following Web sites, your child explores strategies for gathering accurate and reliable information to make important decisions about complex topics. Your child learns when and how to quote, paraphrase, and summarize a variety of sources, such as books, encyclopedias, databases, and the Internet.

· How to Write a Research Paper* from Fact Monster*
· What Is Plagiarism?* from FactMonster
· Grades 7-12* from the Big6*
· Best Note-Taking Strategies* from Scholastic*

Decision Alternatives

In the following Web sites, your child explores how to use notes to develop alternative choices for decisions. Your child also learns how to select and use graphic organizers to help organize information and develop alternative choices for decisions.

· Graphic Organizers* from SCORE*

· Graphic Organizers* from Education Oasis*

· Tools for Reading, Writing, and Thinking* from Greece Central School District*
· Samples* from www.GraphicOrganizers.com*

< Back to Vocabulary | Next to Information >
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about decision making.
Thinking Skills
Critical thinkers are aware of not only what they think, but how they think. You can encourage your child to use critical thinking skills in every subject, from art and literature to math and science.
Your child should know the characteristics of critical thinking:

· Accurate. Critical thinkers are careful to use true information.

· Clear. Critical thinkers communicate in appropriate ways for their audiences.

· Consistent. Critical thinkers always work in orderly and methodical manners.

· Logical. Critical thinkers put information together in orderly ways.

· Objective. Critical thinkers put aside personal feelings and opinions.

· Persistent. Critical thinkers overcome any obstacles they encounter. They continue to think critically until they reach logical conclusions.

· Precise. Critical thinkers use clear and specific ideas and language.

· Reflective. Critical thinkers always monitor their thinking while focusing on tasks at hand.

· Relevant. Critical thinkers only use important information.
Your child should know how to follow a decision making process:
1. Define the decision to be made.

2. Gather information relevant to the decision.

3. Develope alternatives.

4. Evaluate the possibilities of each alternative.

5. Choose the best alternative.

Survey Data
Your child should know that surveys ask questions to collect data on people’s opinions about a topic. An opinion is something a person believes about a topic, while a fact is something that most people agree is true because it is supported by objective data.
Your child should be able to provide examples of facts and opinions, such as:

· Fact: Greenhouse gases that trap heat in the atmosphere cause global warming.

· Opinion: Global warming must be stopped immediately regardless of the economic cost.

Your child should also know how to calculate mean, median, mode, and percentage. Your child should be able to read and interpret charts showing percentages and measures of central tendency.
Decision Defintion
The decision making process can be used to learn about complex topics of interest.
Your child should know some strategies for choosing a topic for a survey:

· Make a list of topics by freely brainstorming ideas

· Evaluate the topics and identify a topic of interest, and think of some decisions that could be made
· Narrow the focus of the topic to a single decision
· Check for sources to make sure enough information is available to make a decision

Your child should be able to distinguish among four types of questions:

· Fact questions always have a correct answer.
· Convergent questions require more explanation than fact questions, but they usually have correct answers.
· Divergent questions usually have many acceptable answers.
· Evaluative questions require judgment to decide among various opinions or answers.
Information Gathering
Plagiarism is failing to cite a source that has been quoted, paraphrased, or summarized. Your child should be able to explain the difference between paraphrasing and summarizing a source. Summarizing involves more analysis than paraphrasing. You can help your child understand that summarizing sources is the best way to avoid plagiarism, but all sources must still be cited in a bibliography.

Your child should be familiar with five basic types of notes:

· Quote. Copying an author’s exact words is the simplest way to take notes.

· Paraphrase. Restating an author’s ideas using different words is often the best way to take notes.

· Summary. Explaining the main points and important details of another author’s ideas is usually the most efficient way to take notes.

· Facts and Data. Recording facts or data from a source is sometimes useful.

· Original Ideas. Recording original ideas while gathering information is important.
Your child should know that they can use a word processing application to take notes and be aware that specialized computer programs can also help with taking notes. Electronic notes have the advantage of being easy to organize as well as quick and easy to search.

Decision Alternatives
Graphic organizers are ideal tools for arranging many pieces of information into a few logical concepts or ideas. An effective graphic organizer is a visual representation of knowledge. You may want to discuss the difference between information and knowledge with your child.

Your child should be familiar with the following types of graphic organizers:

· The fishbone is a popular graphic organizer for showing cause-and-effect relationships.

· A Venn diagram is a popular graphic organizer for comparing and contrasting two or more concepts or ideas.
· A clustering diagram, also called a concept map, is an effective way to sort and group information into categories.

· Some graphic organizers, such as interaction outlines and problem-solution, represent special processes.
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Preview an example of a graphic organizer before reflecting on your child’s work.
See the example: 
Microsoft Word* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child explored critical thinking skills, the decision making process, and survey data. You child defined a decision and gathered information to help develop alternative choices for the decision. Finally, your child demonstrated how to use a graphic organizer to represent knowledge by developing at least two alternative choices for the decision.
Asking your child to share the graphic organizer helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about critical thinking and decision making

· How statistics summarizing survey results can inform decision making

· How to choose topics and define decisions

· How gathered information can be used to developed alternative choices for a decision

< Back to Information | Next to Application >

[PRORAMMING INSTRUCTIONS]
The example below is available for translation and located under the Content and Files Tab > Explain > Make Decisions with Data Examples
	Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DM_DecisionAlternatives_Example.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DM_DecisionAlternatives_Example.pdf


The Rubric below are available for translation and located in the Make Decisions with Data Content Script on the Technology Literacy File Sharing site under the Content and Files Tab > Explain 

	Rubric: Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DecisionMaking_Rubric.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DecisionMaking_Rubric.pdf
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Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
##Search the Help Guide#skillid=null##
Applying Your Child’s Knowledge

You can help your child better understand critical thinking and decision making by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for decision making. Discuss the activities with your child and select any that interest you.

Community Choice
With your child, read local newspapers or watch local news shows on television. Help your child identify an important decision facing your community. First, have your child write research questions that will help make the decision. Then, have your child research the decision by finding credible sources online or in your local library and propose at least two alternatives that could be chosen by members of the community.

Family Purchase
Involve your child in an important family purchase. Discuss what your family needs and some products you could purchase to meet those needs. Have your child brainstorm a list of research questions and gather information about different products that could meet your family’s needs. Have your child create a graphic organizer to represent the advantages and disadvantages of at least two products that your family could purchase. Discuss the alternatives with your child and point out any considerations that may have been omitted.

Survey Roundup

Have your child locate as many examples of surveys as possible during one week. The examples may come from newspapers, magazines, television, or Web sites. Make sure your child finds several examples of survey results reported as percentages. Have your child try to find at least one example each of mean, median, and mode. Discuss with your child why each survey may have been conducted and brainstorm some decisions that could be informed by each of the surveys your child finds.

< Back to Reflection | Next to Data Collection >
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Module Overview
In this module, your child learns how to collect opinion data by administering surveys. You can help your child understand that people’s opinions are often useful data because important decisions have significant effects on people. Your child writes effective survey questions and compiles a questionnaire to collect data from peers. Your child learns how database applications store and manage data for quick and easy retrieval. Finally, your child plans a database to store and manage survey data, and uses a database application to create tables for data.

Activity 1: Survey Questions

Your child explores strategies for writing effective survey questions. Your child creates a questionnaire to practice writing effective open-ended and close-ended survey questions.
Activity 2: Survey Administration

Your child explores ways to collect survey data with questionnaires. Your child works with a partner to conduct pilot tests of a questionnaire and administers a survey.

Activity 3: Database Basics

Your child explores how database applications store and manage data on a computer for quick and easy retrieval. Your child learns how to use a database application to manage survey data.
Activity 4: Database Planning

Your child explores some strategies for planning a database to manage survey data. Your child works with a partner to design a database for the team’s survey data.

Activity 5: Database Tables

Your child explores some ways to create tables in a database application. Your child creates databases from a plan and tests the database with samples of survey data.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about data collection. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Survey Questions
Bias: Tendency to favor one particular point of view.
Close-ended: A type of question that has a limited number of answers from which to choose.

Open-ended: A type of question that allows for several different, detailed answers.

Questionnaire: A list of questions asked in a poll or survey.

Respondent: A person who answers questions in a poll or survey.

Survey: Gather facts and opinions from a sample population by asking questions.
Survey Administration
Administer: Apply or manage a process in a formal way.

Convenience: An appropriate and practical way to accomplish a particular purpose.

Interview: Meet or talk with another person to gather information by asking questions.
Pilot: A test or trial completed as practice or preparation for an event.

Probability: The possibility of an event expressed as a ratio. For example, the probability of a tossed coin landing head-up is one in two (1:2, 1/2, or 0.5).

Professional: Meeting standards of behavior appropriate for work places.

Random: A process that gives every member of a population an equal probability of being selected from a population.

Representative: Providing an example of main characteristics of a group or acting on behalf of the group.

Database Basics

Application: A computer program designed for a specific purpose.

Cell: A single box at the intersection of one row and one column in a worksheet.

Column: A line of cells going up and down, or vertically.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.
Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.

Row: A line of cells going side to side, or horizontally.

Spreadsheet: An application designed to analyze and represent data.

Word Processing Application: A software application designed to create documents.

Workbook: A computer file created with a spreadsheet application and containing one or more worksheets.

Worksheet: A table with rows and columns with cells into which data and formulas can be entered.

Database Planning
Boolean: A type of data that can have only one of two values, such as true or false.

Datum: A single piece of information, such as a fact or statistic, which cannot be divided into smaller pieces.

Primary Key: A field with no duplicate values; that is, no two records in the database have the same value.

Relational Database: A database with more than one table that uses primary keys to relate information stored in one table to information stored in other tables.

Database Tables
Datasheet View: Used to add, edit, and delete information in a table.

Design View: Used to create and define the fields in your table.

Interactive: Performing actions based on input from a user.

Keystroke: Pressing a key on a keyboard.
Wizard: An interactive feature designed to help users of an application perform a specific task in a series of steps.
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Web Sites to Explore with Your Child

You can help your child learn about data collection by exploring some Web sites together. Your child should also learn to use a database application to store data in tables. While exploring the following Web sites, have your child explain the data collection concepts learned in school.


Survey Questions

In the following Web sites, your child explores strategies for writing effective survey questions. Your child learns how to write close-ended and open-ended questions as well as questions to collect demographic data on respondents.

· Types of Survey Questions* from the Encyclopedia of Educational Technology*

· How to Write a Good Survey* from InfoPoll*

· Constructing the Survey* from the Center for Social Research Methods*

Survey Administration

In the following Web sites, your child explores ways to collect survey data with a questionnaire. Your child also learns some basic guidelines for collecting accurate survey data.
· Survey Research* from the Center for Social Research Methods*

· Survey Basics: Data Collection* from the United States Census Bureau*

· How Market Research Works: Other Alternatives* from How Stuff Works*

Database Basics

In the following Web sites, your child learns that a database is a collection of information organized in a way that enables specific information to be retrieved quickly. Your child explores how database applications specialize in storing and managing data on a computer for quick and easy retrieval.

· Database* from NC Wise Owl*

· Introduction to Databases* from Penn State University*

· Databases from Scratch I: Introduction* from Geek Girls*

Database Planning

In the following Web sites, your child explores strategies for planning databases to manage survey data. Your child learns how to break down information into the smallest meaningful data items, create a field for each item, and group fields into tables.

· Plan Your Tables* from Microsoft*

· Databases from Scratch II: Simple Database Design* from Geek Girls*

· Databases from Scratch III: The Design Process* from Geek Girls*

Database Tables

In the following Web sites, your child explores some ways to create tables in a database application. Your child learns how to use a wizard and toolbar to ensure that data is entered correctly.

· Table that Data* from Microsoft*

· Access 2000 Tutorial* from Florida Gulf Coast University*

· Getting Started With Microsoft Access* from the University of Texas*
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about data collection.

Survey Questions
Two basic types of survey questions are close-ended and open-ended. Your child should understand the advantages and disadvantages of each type. Close-ended questions simplify data collection because they have a finite number of possible answers. Open-ended questions can provide more detailed information, but open-ended questions may require more time and effort.
Effective close-ended questions:

· Collect numerical data that is easy to analyze

· Give three or four logical answer choices for each question
· Avoid very long questions or answers

Effective open-ended questions:

· Provide detailed information or quotes

· Are limited to ideas or concepts that are too important or too complex to understand adequately with close-ended questions

Survey Administration
Your child should understand the advantages and disadvantages of different methods of collecting data with questionnaires. Your child should also know how to collect data that can be used to inform decisions.
Your child should be familiar with the following guidelines for collecting valuable data:

1. Identify a population. A population is all members of a group of people from whom facts and opinions will be collected.

2. Select a representative sample. A sample is made up of the members of a population who will be asked to complete a questionnaire.

3. Prepare questionnaires. Determine the best method for delivering the questionnaire to respondents and collecting the completed surveys.

4. Conduct a pilot test. Give the questionnaire to one or two respondents.

5. Deliver the survey. Provide a sample with enough information to complete and return the questionnaire as conveniently as possible.

6. Collect the data. Collect as many completed questionnaires from the sample as possible.

Database Basics
A database is a collection of information organized and stored on a computer so that the information can be quickly and easily searched. Your child should understand that database applications are similar to spreadsheet applications.
Database applications store data in tables made up of rows and columns, similar to worksheets in spreadsheet applications. Just as one workbook in a spreadsheet application may contain many worksheets, one database may contain many tables. In database terminology, rows contain records and columns contain fields.

A record is all the information in a database that pertains to one person, place, or thing. In a survey database, each record contains the data collected from one respondent. A field is one distinct item of information in each of the records. In a survey database, each field contains an answer provided by a respondent to one question.

Database Planning
Your child should know how to plan effective and efficient databases:

1. Consider the purpose.
2. Group data into tables.
3. Define fields for each table.

4. Identify primary keys for each table.

5. Test all tables with sample data.

6. Revise the design.

Database Tables
Your child should know the two main ways to create tables in a database application. Your child can create a table by selecting Design View or Table Wizard from the Insert menu or Database toolbar. Creating a table involves defining fields with a name, a data type, and a description.

Most database applications have at least six data types:

· Text fields store shorter text data, usually up to 255 characters.

· Memo fields store longer text data, usually up to tens of thousands of characters.

· Number fields store most numbers, although you can set the field size property to specific kinds of numbers, such as integers and decimals.

· Date/Time fields store dates and times. You can change the way dates and times are displayed in a field with the format property.

· Currency fields store amounts of money. You can change the way currency data is displayed in a field with the format property.

· Yes/No (Boolean) fields store data than can have only one of two values, yes (1) or no (0).

Your child should know how to create a table with a table wizard:

1. Select sample tables and fields. Select the tables containing fields to be included in the database from the listed sample tables.

2. Set a primary key. A wizard usually sets a primary key by default.

3. Establish relationships. A wizard may ask if the table being creating is related to other tables already in the database.

4. Create the table. A wizard usually opens the table by default.
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Preview an example of database tables before reflecting on your child’s work.
See the example: 
Microsoft Access* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child collected survey data and demonstrated how to use a database application’s menus and toolbars to store survey data in tables.
Asking your child to share the database tables helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about preparing and administering surveys

· How database applications work and how they differ from other applications

· What was learned about planning effective database designs

· How to create database tables and when to choose certain methods
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Applying Your Child’s Knowledge

You can help your child better understand data collection by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for collecting data. Discuss the activities with your child and select any that interest you.

Community Choice II
After your child has proposed at least two alternatives that could be chosen by members of the community, discuss which alternative would most likely be chosen. What data could you collect from people in the community to help make the best choice? Help your child write survey questions and administer the survey to people in the community. Have your child create a database and enter the survey data.

Family Purchase II
After your child has proposed at least two products that your family could purchase, discuss which product would best meet your family needs and make a choice as a family. Involve your child in creating a budget that includes the purchase. Have your child plan a database to store and manage the family budget data. The database should include one table for the budget and a separate table for actual expenses. Make sure the data stored in the two tables can be related by a primary key.

Popularity Contest
Choose important figures from entertainment, politics, or sports that you and your child admire. With your child, use different search engines and search directories to find information about the people. Help your child compile a questionnaire and survey community members to find out what opinions people have about each person. Have your child create a database and enter the survey data.
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Module Overview
In this module, your child learns how to use a database application to store and manage survey data, and a spreadsheet application to analyze and visualize survey data. You can help your child understand how visual representations of data such as charts and graphs can help your child evaluate alternatives and make choices for almost any decision. Your child learns how to create forms and queries to enter and retrieve survey data. Your child also learns how to use formulas and functions as well as charts and graphs to analyze data.

Activity 1: Database Forms

Your child explores how database forms format the data stored in tables so that the data is easier to read. Your child creates database forms and uses the forms to enter survey data.

Activity 2: Database Queries

Your child explores how to use database queries to answer questions with survey data. Your child designs and runs queries that select information to help in decision making.

Activity 3: Decision Possibilities

Your child explores how to use spreadsheet formulas and functions to analyze data. Your child uses formulas and functions to summarize survey data that can be used to evaluate decision alternatives.
Activity 4: Data Visualization

Your child explores how different kinds of charts and graphs visually represent different kinds of data. Your child creates charts and graphs to help visualize data and make a choice.

Activity 5: Decision Choice

Your child makes a choice and explains the decision to peers. Your child formats a worksheet to make data and visualizations easy for peers to read, interpret, and understand.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about data analysis. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Database Forms
Form: A document designed to collect or display information.

Database Queries

Ascending: Ordered from lowest to highest or first to last, such as 1–10 or A–Z.
Criterion: A rule or guide used to measure value and aid in decision making.

Descending: Ordered from highest to lowest or last to first, such as 10–1 or Z–A.
Query: A question or request.

Retrieve: Find and bring back.

Decision Possibilities

Calculate: Find an answer by applying mathematical functions to numbers.

Data Analysis: Selecting and using appropriate formulas and functions to answer questions with data.

Equation: A mathematical expression that includes operators and numbers or variables in which two quantities are equal.

Export: Send data from an application.
Formula: A set format for writing an equation with specific operators and variables (cell references) or numbers.

Function: A built-in formula in a spreadsheet application.

Import: Bring data into an application.

Operator: A symbol that represents a specific mathematical calculation, such as + represents addition.

Value: The number or quantity represented by a variable or formula.

Variable: A letter used in an equation in place of a number that is unknown or can change, such as x in 4 + x = 9.

Data Visualization

Bar Chart: A picture that compares similarities and differences in a set of data.

Graph: Another term for chart, especially one that shows the relationship between two or more sets of numbers, and also shows change over time.

Grid: A system of lines that divides a space into equally sized segments.
Interpret: Understand or explain meaning.

Legend: A box or area that explains the meaning of colors or symbols used in a chart or graph.
Line Graph:  A picture that shows how a set of data changes over time.
Pie Chart: A picture that compares parts of a set of data with each other and to the whole set.
Representation: An image, expression, or example of a topic or idea.

Visual: Using pictures or images to attract viewers’ eyes to information or ideas.

Visualization: A visual representation of information or an idea.

X-axis: The labeled straight line at the bottom of a chart or graph that runs left to right, or horizontally.

Y-axis: The labeled straight line at the side of a chart or graph that runs up and down, or vertically.
Decision Choice

Alignment: Specific arrangement of type and graphics in a publication.

Font: A collection of letters and numbers in the same type.

Type: A style of letters and numbers used in a publication or presentation.
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Web Sites to Explore with Your Child

You can help your child learn about the data analysis by exploring some Web sites together. While exploring the following Web sites, have your child explain the data analysis concepts learned in school.


Database Forms

In the following Web sites, your child explores how database forms format the data stored in tables so that the data is easier to read. Your child learns how to create database forms quickly and efficiently by selecting a wizard from a menu or toolbar.

· Forms I: Create a Form to Enter and View Your Data* from Microsoft*

· Forms* from Florida Gulf Coast University*

· Databasics III: Data Entry Design* from Geek Girls*

Database Queries

In the following Web sites, your child explores how to use database queries to answer questions with survey data. Your child learns how to design basic queries by selecting the fields that contain the needed information and specifying criteria that retrieves the proper records.

· Queries I: Get Answers with Queries* from Microsoft*

· Queries* from Florida Gulf Coast University*
· Databasics V: Getting Information Out* from Geek Girls*

Decision Possibilities

In the following Web sites, your child explores the use of spreadsheet formulas and functions to analyze data. Your child learns how to export query results from a database application and import the data into a spreadsheet application. A spreadsheet application is usually the best tool for analyzing data.

· Microsoft Excel Modules* from Internet4Classrooms*

· Entering Formulas* from the EHS Virtual Computer Lab*

· How to Use Excel Spreadsheet Formulas* from About*
Data Visualization

In the following Web sites, your child explores how charts and graphs visually represent relationships among data. Your child learns how to use toolbar and wizard features of a spreadsheet application to create charts and graphs.

· Graph Types* from NCEAS*

· Create a Graph* from NCES Kids*
· Creating Graphs from Excel Data* from the EHS Virtual Computer Lab*

· How to Use the Excel Chart Wizard* from About*

Decision Choice

In the following Web sites, your child learns how to make a decision and explain the decision to peers. Your child also learns how to format worksheets so that others can easily see collected data and the data used to evaluate decision alternatives.

· The Formatting Toolbar* from Internet4Classrooms*

· Basic Formatting in Excel—Tutorial Part 1* from About*

· Basic Formatting in Excel—Tutorial Part 2* from About*
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What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about data analysis.

Database Forms
Electronic forms have two parts—controls and labels. Controls accept information from users and display information from a database. Labels tell people who use the form what each control does. Most controls are bound to fields in a database. Your child should be able to identify common form controls, such as text box, option (radio) button, check box, list box, combo box, and command button.

In most database applications, creating a form involves the following five basic steps:

1. Select tables. Select the tables that contain the data.
2. Select fields. Select the table fields to be included in the form.

3. Choose layout. Choose the form’s basic layout.

4. Format labels. Choose a label format from a number of basic designs.
5. Create the form. The form usually opens by default.
Database Queries
Queries retrieve information from a database. Queries can be as simple as retrieving all the records that contain a certain value in a particular field, but they can also be extremely complex, involving long and complicated logical and mathematical operations.
In most database applications, creating a query involves five basic steps:

1. Select tables. Select the tables that contain the data.

2. Select fields. Select the table fields to be included in the query.

3. Show and sort. Choose which fields to display and how to sort the results.

4. Set criteria. Set criteria that will select only the necessary records.

5. Save the query. Save the query from the File menu.

Decision Possibilities
Data analysis involves selecting and using appropriate formulas and functions to answer questions. You can remind your child to use critical thinking skills to select and use the most appropriate formulas and functions to analyze data.

Your child should know how spreadsheet applications use formulas and functions to calculate data. A formula is an equation that is entered into a spreadsheet that can include cell references. A function is a standard formula that is built into a spreadsheet application. The difference is that users create formulas and the application includes functions.

Your child should know that spreadsheet applications have two main advantages:

· They can perform numerous calculations instantly.

· They can update calculations automatically when data changes.

Data Visualization
Certain kinds of data require particular types of charts and graphs to represent them. Your child should be able to recognize the three main types of charts and graphs and the main parts of a chart or graph.
The most common types of charts and graphs are:
· A bar chart compares similarities and differences in a set of data.
· A line graph shows how a set of data changes over time.

· A pie chart compares parts of a set of data with each other and to the whole set.
The main parts of a chart or graph are:

· Title: The title of a chart should quickly describe what the chart is about.

· X-axis: The x-axis should have a title that describes what type of data is shown horizontally in the graph.

· Y-axis: The y-axis should have a title that describes what type of data is shown vertically in the graph.

· Legend: The legend describes how data is represented in the chart.
The four basic steps for creating a chart with a wizard are:

1. Select chart type. Select a chart type from the list.

2. Indicate chart source data. Indicate whether the data to be represented is stored in rows or columns.
3. Determine chart options. Give a descriptive title to the chart, x-axis, and y-axis.
4. Decide chart location. Specify whether to place the chart on a new worksheet or an existing worksheet in the same workbook.

Decision Choice
Formatting worksheets is just as important as formatting word processing documents. The graphical user interface for formatting a spreadsheet is very similar to the GUI in a word processing application. You can make sure your child is familiar with the Format menu and toolbar in spreadsheet software.

Your child should understand how formatting and sharing data with peers can help improve data analysis and decision making. Decision makers often print worksheets and data visualizations to share with peers. Sometimes, they create posters that explain their choices and how they made their decisions. Your child should understand how to use feedback to help evaluate all alternatives with reason and fairness when making a decision.
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Preview an example of a decision choice and a decision explanation before reflecting on your child’s work.
See the examples:
Microsoft Excel* | PDF
Microsoft Word* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child created a form to enter survey data into a database, created a query to retrieve information from a survey database, analyzed survey data to help make a decision, and created a chart or graph to help evaluate alternatives and make a choice.

Asking your child to share the choices helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· What was learned about creating queries and forms in a database application

· How were data and alternative choices analyzed and evaluated to make a decision

· What was learned about reading and interpreting charts

· What was learned by sharing evaluations and choices with others
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Applying Your Child’s Knowledge

You can help your child better understand data analysis by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for analyzing data. Discuss the activities with your child and select any that interest you.

Chart Roundup
Have your child locate examples of as many different types of charts and graphs as possible during one week. The examples may come from newspapers, magazines, television, or Web sites. Make sure your child can identify each kind of chart or graph and locate the title, x-axis, y-axis, and legend when applicable. Have your child read and interpret each chart or graph and explain what it means to you or other family members.
Community Choice III
Help your child create queries to select information that will help people in the community make the best choice. Have your child use formulas and functions to analyze selected survey data. Discuss with your child what kinds of charts and graphs would be most appropriate for representing the survey data. How can your child use the charts or graphs to help people in your community make the best choice?
Popularity Contest II
Help your child use formulas and functions to analyze the poll data collected on important figures from entertainment, politics, or sports that you and your child admire. Discuss with your child the kinds of charts and graphs that would be most appropriate for representing the data. Have your child create charts and graphs from the data. Remind your child to format the charts and graphs so they are easy for others to read and interpret.
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Module Overview
In this module, your child learns how to use the expository style of writing to explain a decision to a live audience. Your child should know what technology tools can be used to create and deliver a presentation and be able to use them effectively. You can help your child understand how to use multimedia to create and deliver a presentation that is entertaining as well as interesting and informative.

Activity 1: Expository Nonfiction

Your child explores the use of expository writing in presentations. Your child analyzes the use of expository writing in presentations on subjects of interest.
Activity 2: Presentation Outline

Your child explores the characteristics that make a presentation interesting and informative. Your child outlines an expository presentation to explain a decision.

Activity 3: Presentation Design

Your child explores how visual representations of information can make a strong impression on people. Your child designs a visually appealing presentation based on an outline.

Activity 4: Multimedia Management

Your child explores legal and ethical use of multimedia to enhance a presentation. Your child finds images, audio, or video on the Internet to help explain a decision.

Activity 5: Presentation Delivery

Your child explores strategies for delivering interesting, informative, and entertaining presentations to a live audience. Your child prepares, practices, and delivers an expository presentation.
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Words Your Child Should Know
This page gives basic definitions for key terms that can help your child learn about expository presentations. You can get a more complete definition of each term from Fact Monster*.

You can quiz your child or help your child draw an image or symbol that represents each word. You should encourage your child to use the vocabulary words in sentences at home and provide positive feedback for using the terminology correctly.


Expository Nonfiction
Audience: The people who read a publication or view a work of art, performance, or presentation.

Cause: A person, group, event, idea, action, or object that produces a specific result or outcome.

Classify: Arrange people, groups, places, events, ideas, actions, or objects so that each one is assigned to a category.

Compare: Study two (or more) people, groups, places, events, ideas, actions, or objects to identify shared characteristics.

Divide: Separate people, groups, places, events, ideas, or things so that each one is placed into a category.

Effect: A specific result or outcome produced by something said or done by a person, group, event, idea, or thing.

Expository: A type of writing that explains a topic or informs an audience.

Interpret: Understand or explain meaning.

Nonfiction: Any creative work that describes or comments on actual events, such as a newspaper article or biography.

Presentation: An explanation of a topic given in the presence of an audience.

Presentation Outline

Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.

Outline: A general overview or summary of the basic structure of information.

Structure: An arrangement of specific parts in ordered relationships to form a whole.

Presentation Design

Application: A computer program designed for a specific purpose.

Balance: Overall distribution of type and graphics on a page to create a desired effect.
Graphic Design: The art of using type and graphics to communicate information with a desired effect.

Peer: A person who is similar to another, as in age, grade, or career.

Presentation Application: A software application designed to create multimedia presentations.

Program: A set of instructions for a computer to perform.

Proximity: How close together type or graphics are arranged in a publication or presentation; usually used in design to create a desired effect.
Repetition: Type or graphics used more than once to create a desired effect.
Revise: Carefully review and improve the content of a creative work.

Software: Any computer program and any information included with the program.
Template: A computer file designed to open a copy of itself by default so its formatted content can be used and modified to create similar documents.
White Space: An area of a publication with no type or graphics.

Multimedia Management

Compress: Change how data is stored so it takes up less space on a computer.

Copyright: Law that prohibits any creative work from being used without permission.

Download: Transfer a file from another computer to your computer.

Extension: A period and letters attached to the end of a filename indicating the file’s format.

Fair Use: Limited use of a copyrighted work for certain purposes, such as education.

Format: A specific way to store a particular kind of data in a computer.

Multimedia: Combining more than one type of information, such as words, numbers, images, audio, and video.

Public Domain: Creative works that may be used without permission because the copyright has expired.
URL (Uniform Resource Locator): The address of a Web page consisting of the protocol and domain name and sometimes the path and filename.

Presentation Delivery

Conversational: A casual or informal manner of exchanging information or ideas.

Hardware: Any physical device that is part of computer or can be used with a computer.

Input: Data entered into a computer.

Output: Data produced by a computer.

Peripheral: Any device that can provide input to a computer or accept output from a computer.
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Web Sites to Explore with Your Child

You can help your child learn about creating a presentation to explain a topic by exploring some Web sites together. Your child should learn how to use multimedia to create and deliver presentations that are entertaining as well as interesting and informative. While exploring the following Web sites, have your child explain the expository presentation concepts learned in school.


Expository Nonfiction

In the following Web sites, your child explores how the expository style of writing can help explain topics and inform audiences. Your child learns how to create effective presentations that explain decisions to live audiences by conveying the most important ideas and concepts.

· You Got Some 'Splaining to Do, Lucy: Exposition* from Fact Monster*
· Writing Workshop: Research Paper* from Scholastic*

· Expository Essay* from Essay Info*
Presentation Outline

In the following Web sites, your child explores the characteristics that make a presentation interesting and informative. Your child learns to create presentations that use few words to convey the most important ideas and concepts by outlining the main concepts and supporting comments.

· Organize Your Ideas* from Fact Monster*
· Outline* from Essay Info*

· Developing an Outline* from the Online Writing Lab*

Presentation Design

In the following Web sites, your child explores how visual representations of information can make a strong impression on most people. Your child learns that graphic design is the art of creating publications and presentations that capture and hold the attention of readers and viewers.

· Microsoft PowerPoint* from Internet4Classrooms*

· Open Office Impress Tutorial* from GCF Global Learning*

· Principles of Design* from About*

Multimedia Management

In the following Web sites, your child explores how to use multimedia to create a presentation that is entertaining as well as interesting and informative. Your child also learns about copyright laws and fair use laws relevant to the multimedia that may be used to enhance an expository presentation.

· Download Files* from Learn the Net*

· Copyright Questions and Answers* from CyberBee*

· Copyright Kids* from The Copyright Society of the U.S.A*

Presentation Delivery

In the following Web sites, your child explores strategies for delivering an interesting, informative, and entertaining presentation to a live audience. Your child learns how to prepare and practice a presentation, and speak to an audience in a professional but conversational tone.

· 12 Tips for Delivering a Knockout Business Presentation* from About*

· How to Lose an Audience in 10 Easy Ways* from About*

< Back to Vocabulary | Next to Information >

	Type of Page 
	Level 4 Content Page

	Supertitle
	Make Decisions with Data | Expository Presentation

	Headline Title
	Information


[left-hand nav TEXT]
Vocabulary
Exploration
Information
Reflection

Application

What Your Child Should Know

This page summarizes some of the information from the recommended Web sites you may have explored with your child. You can use this page to make sure your child learns the most important information about expository presentations.

Expository Nonfiction
The expository style of writing is appropriate for most presentations because most presentations explain a topic to a live audience. Effective presentations use few words to convey the most important ideas and concepts. Your child should understand that well-crafted slides and well-written paragraphs share many characteristics.

Your child should be able to distinguish five types of expository writing:
· Cause-and-effect expositions explain why an event happens.
· Classify-and-divide expositions sort people, groups, places, events, ideas, actions, or objects into categories based on similarities and differences.

· Compare-and-contrast expositions explain the similarities and differences among people, groups, places, events, ideas, actions, or objects.

· Definition expositions explain the most important characteristics of a person, group, place, event, idea, action, or object.

· Process expositions tell an audience how to complete an action. They follow a sequence from a starting point to a successful conclusion.
Presentation Outline
Your child should know how to outline the structure of a presentation before creating slides. The structure of an expository presentation consists of two basic elements—the main points needed to explain a topic and the supporting points that explain the main points.

Make sure you child can use the following steps to create outlines:

1. Identify main points needed to make a decision.
2. Determine the most logical order of main points.
3. Give each main point a short, descriptive label.
4. Identify the supporting points needed to explain each main point.
5. Determine the most logical order of supporting points for each main point.
6. Give each supporting point a short, descriptive label.
Presentation Design
A quality presentation looks good, is easy to read from a distance, and communicates a message. Your child should know the basic “dos and don’ts” for designing a quality presentation. The overarching theme is to use design elements creatively but correctly and sparingly so that a design is visually appealing and easy to read or view.

Your child should understand the six basic principles of graphic design:

· Alignment makes a publication easy to read.

· Balance sets the tone for a publication.
· Contrast directs a reader’s attention to a specific place or idea.

· Proximity uses space to show how type and graphics are related.

· Repetition helps a reader navigate through a publication.

· White space gives a reader’s eyes a rest.

Multimedia Management
Computer files are stored in particular formats that are indicated by file extensions. All formats are good for some purposes but not for others.

· Images can be saved in many formats. Most of the images on the Web are GIF or JPEG (or JPG) files.

· Audio, like images, can be saved in many formats. One audio format that almost everyone is familiar with is MP3.

· Video also can be saved in many formats. MPEG is a video format from the same organization that developed the MP3 audio format. Unlike image and audio formats, no video format appears to be the most popular format on the Internet.

Your child should assume that a work is copyrighted even if it is not marked with a copyright symbol ©. Fair use of copyrighted works for educational purposes applies only under certain conditions and limitations. No exact rules exist for fair use in all cases, but your child can follow some accepted guidelines for school projects. You can make sure your child always gives credit to the creators of images just as they cite the authors of text.

Presentation Delivery

Your child should know how to do the following before delivering a presentation:

· Review the presentation with Slide Sorter on the View menu

· Run the presentation from either the View or Slide Show menu

· Practice delivering the presentation in front of a mirror, friend, or trusted adult

· Connect and use the projector

Your child should know how to do the following during a presentation:

· Speak to the audience in a professional yet conversational tone

· Summarize the main points on slides instead of reading from them or reciting them from memory

· Watch the audience to make sure they are understanding the presentation

· Watch the time and try to stay on schedule
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Preview an example of a final presentation before reflecting on your child’s work.
See the example: 
Microsoft Powepoint* | PDF
Use the rubric to help you understand what is important for your child to know and do.
See the rubric: 
Microsoft Word* | PDF
Reflecting on Your Child’s Work

In this module, your child explained a decision by delivering an interesting, informative, and entertaining multimedia presentation.
Asking your child to share the presentation helps your child remember what was learned in class. Your child can learn by sharing work with you and other trusted adults in your family or community.

Encourage your child to discuss the following points:

· Why most presentations are examples of expository nonfiction

· What was learned about presentation tools and graphic design

· What was learned about managing multimedia legally and ethically

· How to prepare to deliver an expository presentation
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[PRORAMMING INSTRUCTIONS]
The example below is available for translation and located under the Content and Files Tab > Explain > Make Decisions with Data Examples
	Microsoft* Powerpoint

	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/EP_PresentationDelivery_Example.ppt

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/EP_PresentationDelivery_Example.pdf


The Rubric below are available for translation and located in the Make Decisions with Data Content Script on the Technology Literacy File Sharing site under the Content and Files Tab > Explain 

	Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/ExpositoryPresentation_Rubric.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/ExpositoryPresentation_Rubric.pdf
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Use the Intel® Education Help Guide to get just-in-time assistance with technology skills needed for these home activities.
##Search the Help Guide#skillid=null##
Applying Your Child’s Knowledge

You can help your child better understand how to create and deliver an expository presentation by applying the knowledge and skills your child learns in school to home activities. This page suggests some optional home activities for creating multimedia presentations to explain a topic. Discuss the activities with your child and select any that interest you.

Community Choice IV
Have your child use presentation tools and graphic design principles to create a multimedia presentation that will help people in the community make the best choice. Make sure your child uses charts and graphs to explain how survey data can inform the decision. Encourage your child to use appropriate images, audio, or video to enhance the presentation. If possible, have your child deliver the presentation to members of the community. Make sure the audience asks your child questions about the survey. Discuss the presentation with your child and brainstorm some ideas for making the presentation more entertaining or informative.
Family Album
Help your child make a list of all scheduled activities for each member of your family over the next month. Have your child choose some activities to attend and write short expository nonfiction articles to explain the activities to other family members and friends. Take digital photographs of the activities and videotape some of the activities if possible. Help your child use desktop publishing tools and graphic design principles to produce a family album for the month. Share the presentation with other family members and friends.

Popularity Contest II
Have your child create an expository presentation to explain survey results with other family members, friends, or people in the community. Make sure your child uses charts and graphs to explain how survey data can inform a decision. Encourage your child to use appropriate images, audio, or video to enhance the presentation. Have your child deliver the presentation to other family members or friends. Make sure the other family members or friends ask your child any questions they may have about the person’s career and offer suggestions to make your child’s presentation more entertaining or informative.
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